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Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and conditions of this
legal disclaimer before you read or use this document. If you have read or used this document, it

shall be deemed as your total acceptance of this legal disclaimer.

1. You shall download and obtain this document from the Alibaba Cloud website or other Alibaba
Cloud-authorized channels, and use this document for your own legal business activities only.
The content of this document is considered confidential information of Alibaba Cloud. You shall
strictly abide by the confidentiality obligations. No part of this document shall be disclosed or
provided to any third party for use without the prior written consent of Alibaba Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted, or disseminat
ed by any organization, company, or individual in any form or by any means without the prior
written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades, adjustment
s, or other reasons. Alibaba Cloud reserves the right to modify the content of this document
without notice and the updated versions of this document will be occasionally released through
Alibaba Cloud-authorized channels. You shall pay attention to the version changes of this
document as they occur and download and obtain the most up-to-date version of this document
from Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud products and
services. Alibaba Cloud provides the document in the context that Alibaba Cloud products and
services are provided on an "as is", "with all faults" and "as available" basis. Alibaba Cloud
makes every effort to provide relevant operational guidance based on existing technologies
. However, Alibaba Cloud hereby makes a clear statement that it in no way guarantees the
accuracy, integrity, applicability, and reliability of the content of this document, either explicitly
or implicitly. Alibaba Cloud shall not bear any liability for any errors or financial losses incurred
by any organizations, companies, or individuals arising from their download, use, or trust in
this document. Alibaba Cloud shall not, under any circumstances, bear responsibility for any
indirect, consequential, exemplary, incidental, special, or punitive damages, including lost
profits arising from the use or trust in this document, even if Alibaba Cloud has been notified of
the possibility of such a loss.

5. By law, all the content of the Alibaba Cloud website, including but not limited to works, products
, images, archives, information, materials, website architecture, website graphic layout, and
webpage design, are intellectual property of Alibaba Cloud and/or its affiliates. This intellectu

al property includes, but is not limited to, trademark rights, patent rights, copyrights, and trade



secrets. No part of the Alibaba Cloud website, product programs, or content shall be used,
modified, reproduced, publicly transmitted, changed, disseminated, distributed, or published
without the prior written consent of Alibaba Cloud and/or its affiliates. The names owned by
Alibaba Cloud shall not be used, published, or reproduced for marketing, advertising, promotion
, or other purposes without the prior written consent of Alibaba Cloud. The names owned by
Alibaba Cloud include, but are not limited to, "Alibaba Cloud", "Aliyun", "HiChina", and other
brands of Alibaba Cloud and/or its affiliates, which appear separately or in combination, as well
as the auxiliary signs and patterns of the preceding brands, or anything similar to the company
names, trade names, trademarks, product or service names, domain names, patterns, logos

, marks, signs, or special descriptions that third parties identify as Alibaba Cloud and/or its
affiliates).

6. Please contact Alibaba Cloud directly if you discover any errors in this document.
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Generic conventions

Table -1: Style conventions

Style Description Example
This warning information indicates a
situation that will cause major system Danger:
changes, faults, physical injuries, and Resetting will result in the loss of user
other adverse results. configuration data.
This warning information indicates a
''''' situation that may cause major system | &% Warning:
changes, faults, physical injuries, and | Restarting will cause business
other adverse results. interruption. About 10 minutes are
required to restore business.
This indicates warning information,
supplementary instructions, and other Note:
content that the user must understand. | Take the necessary precautions to
save exported data containing sensitive
information.
This indicates supplemental instructio
ns, best practices, tips, and other Note:
content that is good to know for the You can use Ctrl + A to select all files.
user.
> Multi-level menu cascade. Settings > Network > Set network type
Bold It is used for buttons, menus, page Click OK.
names, and other Ul elements.
Couri er It is used for commands. Runthecd /d C./w ndows command
f ont to enter the Windows system folder.
Italics |[Itisused for parameters and variables. |bae 1 og list --instanceid
I nstance_I D
[] or [a]b] It indicates that it is a optional value, i pconfig[-all]|-t]
and only one item can be selected.
{} or{alb} |Itindicates that it is a required value, swich{stand | slave}
and only one item can be selected.
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1 Client

This article describes how to use the basic functions of the MaxCompute using client command

line tool. Before using the MaxCompute client, you must install and configure the client .

Note:

* Do not perform the analysis operation based on the output format of the client. The output
format of the client is not ensured for forward compatibility. Clients of different versions are

different in their command formats and behaviors.
* For more information about basic commands of the client, see Basic commands.
* Download MaxCompute console

* The client supports JDK 1.9 from the 0.28.0 version, and the previous version can only use

JDK 1.8.

* The client supports MaxCompute 2.0 from the 0.27.0 version New data type.

After the client is installed and configured, you can use a command line to perform the following

operations.
Get Help
To view the help information of the console, the command format is as follows:
odps @>./ bi n/ odpscnd- h;
You can also input h; or hel p; (case-insensitive) in an interactive mode.

The console also provides the hel p [ keyword] ; command to get the command prompts
related to the keyword. For example, input hel p t abl e; to get command prompts related to the

table operation as follows:

odps @ odps> hel p table;
Usage: alter table nmerge smallfiles
Usage: show tables [in]

alist of tables | Is [-p,-project]
Usage: describe deserves nmention | [ [partition ()]
Usage: read [.] [partition ()] [Iine_nuni

ec
]

Start parameters

When start the console, you can specify a series of parameters as follows:

Usage: odpscnd [option]...


http://repo.aliyun.com/download/odpscmd/latest/odpscmd_public.zip

wher e options include:
--help (-h) for help
--project= use project
--endpoi nt = set endpoi nt
-u-p user name and password
-k will skip begining queries and start from specified position
-r set retry tines
-f <"file_path;"> execute command in file
-e <"command; [command;]..."> execute comand, include sgql command
-Cwill display job counters

Take the -f parameter as an example, the operation is as follows:

1. Prepare the local script file script.txt. Suppose that the file is located in the disk D, and the

content is shown as follows:

DROP TABLE | F EXI STS test _table_nj;
CREATE TABLE test _table_nm (id string, name string);
DROP TABLE test_table_nj;

2. Run the following command:
odpscrd\ bi n>odpscnd -f D:/script.txt;
Interactive mode

Run the console to directly enter the interactive mode:

[adm n: ~] $odpscnd

Al'i yun ODPS Command Li ne Tool

Version 1.0

@Copyright 2012 Ali baba C oud Conputing Co., Ltd. Al rights reserved.
odps@ odps> | NSERT OVERWRI TE TABLE DUAL SELECT * FROM DUAL;
Enter the command at the cursor position (use a semicolon as a statement terminator), and press

Enter to run.
Continuous running

»  When using -e or -f option to run a command, if there are multiple statements, and you want to
start running from a middle statement, you can specify the parameter -k, indicating to ignore
the previous statements and to start running from the specified position. When the parameter
<= 0 is specified, the execution starts from the first statement.

+ Each statement separated by a semicolon is considered as a valid statement. The statements

which run successfully or fail to run are printed out at runtime.

For example,



suppose there are three SQL statements in the file /tmp/dual.sql:

drop tabl e dual;
create table dual (dummy string);
insert overwite table dual select count(*) from dual;

To ignore the first two statements, and start running from the third statement, the command format

is as follows:
odpscnd -k 3 -f dual. sql
Get current logon user
To get current logon user, the command format is as follows:
whoam ;

Use example:

odps @ hi veut >whoam ;

Nane: odpstest@liyun.com

End_Poi nt: http://service. odps. aliyun. conf api
Project: lijunsecuritytest

Use the preceding command to get the current logon user Alibaba Cloud account, endpoint

configuration, and project name.
Exit
To exit the console, the command format is as follows:
odps@> quit;
You can also use the following command to exit the console:

odps@ > q;



2 MaxCompute Studio

2.1 What is Studio

MaxCompute Studio is a big data integrated development environment (IDE) tool that is provided
by the Alibaba Cloud MaxCompute platform and installed on the developer’s client. It is a
development plug-in based on the popular integrated development platform IntelliJ IDEA, helping
users develop data conveniently. This article describes functional interfaces and common

application scenarios of MaxCompute Studio.
Basic user interface

MaxCompute Studio is a plug-in on the IntelliJ IDEA platform, which shares basic development
interfaces with Intellid IDEA. For more information about the IntelliJ IDEA interfaces, see the

Interface operation guide.

Based on the IntelliJ IDEA interfaces, MaxCompute Studio provides the following functional

interfaces.

+ SQL Editor: Provides features such as SQL syntax highlighting, code complementing, real-

time error prompting, local compilation, and job submission.

Compiler View: Displays locally compiled prompts and error messages, and locates the code in
the editor.
* Project Explorer: Connects to a MaxCompute project, and browses table structures, custom

functions, and resource files in the project.

Table Details View: Displays details and sample data of tables, views, and other resources.

+ Job Explorer: Browses and searches for historical jobs of MaxCompute.

— Job Details View: Displays running details of a job, including the execution plan and details
of each execution task.
— Job Output View: Displays output information of a running job.
— Job Result View: Displays the output result of the SELECT job.
+ MaxCompute Console: Integrates the MaxCompute client, on which MaxCompute client

commands can be input and executed.
Connect to MaxCompute project

Before using most features of MaxCompute Studio, you must Create a project connection. After

the project connection is created, you can view related data structures and resource information in


https://www.jetbrains.com/idea/
https://www.jetbrains.com/help/idea/2016.3/guided-tour-around-the-user-interface.html
https://www.jetbrains.com/help/idea/2016.3/guided-tour-around-the-user-interface.html

the Project Explorer. MaxCompute Studio automatically creates a local metadata backup task for

each project to increase the access frequency to MaxCompute metadata and reduce the latency.

Note:

* You must specify the target project connection to modify SQL scripts, submit jobs, view
job information, open the MaxCompute console, and implement other functions using
MaxCompute Studio. Therefore, creating a connection to the MaxCompute project is
necessary.

* For more information about MaxCompute projects, see Project.

* For more information about project management using MaxCompute Studio, see Project

space connection management.
Manage data

You can use the Project Explorer of MaxCompute Studio to quickly browse table structures,
custom functions, and resource files in the project. The tree control can be used to list data tables,
columns, partition columns, virtual views, custom functions, function signatures, and resource files

and types of all project connections. It also supports fast locating.

You can double-click a data table to open the Table Details View and view metadata, structure,
and sample data of the data table. If you do not have the permission for a project, an error

message is prompted.

MaxCompute Studio integrates MaxCompute Tunnel and supports local data upload and

download. For more information, see Import and export data.
Write SQL scripts
You can easily compile a MaxCompute SQL script on MaxCompute Studio.

1. Open MaxCompute Studio and select File > New > Project or File > New > Module....
2. Create a MaxCompute Studio project or module.

3. Select File > New > MaxCompute Script or right-click the menu and select New >

MaxCompute Script , to create a maxcompute SQL script file.

Note:
When a MaxCompute SQL script is created, MaxCompute Studio prompts you to select
an associated MaxCompute project. You can also modify the associated project using the

project selector on the right of the toolbar on the SQL editor. The editor automatically checks



metadata (such as the table structure) and reports errors of an SQL statement based on
the project associated with the SQL script. The editor also sends the SQL statement to the
associated project for execution when it submits the SQL statement for running. For more

information, see Compile an SQL script.
SQL code intelligent prompt

After you enter the code, the SQL editor provided by MaxCompute Studio intelligently prompts the
syntax errors, type matching errors, or warnings of SQL statements, and marks them on the code

in real time. as shown in the following figure.

. key value + c.value

Lrmse = L Lrmse = Lr

table meta.srcp cannot be resolved

By using the code complementing function, MaxCompute Studio prompts you the name, table,
field, function, type, and code keyword of a project based on the code context, and automatically

complements the code based on your selections. as shown in the following figure.

Compile and submit a job
+ Compile a job

Click the m icon on the toolbar of the SQL editor to locally compile an SQL script. If syntax

or semantic errors occur, the editor reports it.



Information: Parsing ...

Information: Type checking ...

Information: Latency.compiler_parse_error : 44170
Information: Build failed(2)

v El fUsers/xueming.xm/ldeaProjects/MyUDF/Script/scripts
® Error:(9, 15) table meta.table_test cannot be resolved
® Error:(12, 8) table meta.table_test cannot be resolved

+ Submit a job

Click the - icon on the toolbar of the SQL editor to submit an SQL script to the queue of

the project specified by MaxCompute.
View history jobs

Open Job Explorer to view recently executed jobs in the specified project.

@ Note:

List only displays jobs submitted by the user ID of the current connection.



MaxCompute Job Explorer
Project

lable| »

ime | EndTime

U

rtTime d )
2017-02.
n REL3692

sql_optimizer.dual

ADHOC_SINK 3693
FS: output: None

If you have the Log view URL of a job, you can select MaxCompute > Open Logview from the

menu to go to the details page of the job.



Develop a MapReduce program and UDF program
MaxCompute Studio also allows you to develop MapReduce and Java UDF programs.
Connect to a MaxCompute client

MaxCompute Studio is integrated with the MaxCompute Client of the latest version. Alternatively,
you can specify the path of the locally installed MaxCompute client on the Configuration page of

MaxCompute Studio.

On the Project Explorer, right-click a project and select Open in Console to open the

MaxCompute Console window.

MaxCompute Console

naba Cloud Computing Co., Ltd. ALL rights reserved.

% 6 TODO x| Terminal MaxCompute Console Running Info

Next step

Now, you know the functional interfaces and common application scenarios of MaxCompute
Studio. Continue to the next tutorial. In this tutorial, you will learn how to install MaxCompute

Studio. For more information, see Install IntelliJ IDEA.

2.2 Tools Installation and version history

2.2.1 Install IntelliJ IDEA

This document describes how to install the basic platform IntelliJ IDEA of MaxCompute Studio.

Context

Procedure

Procedure

1. Click here to download the IntelliJ IDEA of the version corresponding to your operating system
(Windows, macQOS, or Linux). The following assumes that the Windows operating system is

used.


https://www.jetbrains.com/idea/?spm=5176.doc50889.2.1.0ohIYs

Download IntelliJ IDEA 14.1.4 or a later version. (The Ultimate version, PyCharm version, and

free Community version are supported.)

2. After the download is complete, double-click the installation program to enter the installation

page, and click Next, as shown in the following figure.

Intelli) IDEA Community Edition Setup ==

Welcome to IntelliJ IDEA Community
Edition Setup

Setup will guide you through the installation of Intellil IDEA
Community Edition.

It is recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue.

3. Specify the installation directory, and click Next, as shown in the following figure.




m Intelli) IDEA Community Edition Setup = |
i A e e Y

Choose Install Location
Choose the folder in which to install Intellil IDEA Community
Edition.

Setup will install Intellil IDEA Community Edition in the following folder. To install in a different
folder, didk Browse and select another folder, Click Mext to continue.

Destination Faolder

agram Files\JetBrains\Intelli] IDEA Community Edition 2017.1.5

Space reguired: 731,.5MB
Space available: &, 5GE

< Back I Mext = | Cancel |

4. Select the 32-bit or 64-bit IntelliJ IDEA based on the version of the local operating system.

You can query the local operating system version by following these steps:

a) Open Windows Resource Manager, right-click Computer and select Properties from the

shortcut menu. as shown in the following figure.
b) In the displayed window, check the type of the operating system.

5. Select the corresponding system type and click Next , as shown in the following figure.
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m Intelli) IDEA Community Edition Setup =l
Installation Options
Configure your Intellil IDEA Community Edition installation
Create Desktop shortout

[7] 32-bit launcher &4-bit launcher

Create assodations

[0 .java [].groovy  [] .kt

=S ] ==

6. Click Install to start installation, as shown in the following figure.

EN Intelli) IDEA Community Edition Setup =NNE X
Choose Start Menu Folder
Choose a Start Menu folder for the Intelli] IDEA Community
Edition shortouts,

Select the Start Menu folder in which you would like to create the program's shortouts. You
can also enter a name to create a new folder.

TV R

7-dip

Accessories
Administrative Tools
Adobe

e e (290

Cisco

Diagram Designer
doPDF 7

eDiary

Games

Java -

<Back || nstal |f| cancel
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E? Intelli) IDEA Community Edition Setup o] = || 23
Installing
Flease wait while Intellil IDEA Community Edition is being
installed.

Extract: btn_togale_off_focused_holo_dark.9.png... 100%:

< Badk Mext = Cancel

7. After the installation is complete, click Finish.

ER Intelli) IDEA Community Edition Setup = e e

Completing IntelliJ IDEA Community
Edition Setup

Intelli] IDEA Community Edition has been installed on your
computer,

Click Finish to dose Setup.

[ Run Inteli] IDEA Community Edition

< Bacdk I Finish I Cancel

What's next

Issue: 20181128 13



Now you know how to install IntelliJ IDEA. Continue to the next tutorial. In this tutorial, you
will learn how to install the MaxCompute Studio plugin. For more information, see Install the

MaxCompute Studio plugin.

2.2.2 Installation procedure

Environment requirements

IntelliJ IDEA can be installed on Windows, Mac, Linux. For more information about the hardware
and system environment requirements, click here . IntelliJ IDEA-based MaxCompute Studio can

also be installed on clients running these operating systems.
MaxCompute Studio has the following requirements on the your environment:

» Aclient running Windows, macOS, or Linux.

* Intellid IDEA 14.1.4 or a later version is installed. (The Ultimate version, PyCharm version, and
free Community version are supported.)

+ JRE 1.8 is installed. (JRE 1.8 has been bound to the latest IntelliJ IDEA.)

+ JDK 1.8 is installed. (Optional: JDK is required if you need to develop and debug Java UDF.)

Note:
The client supports JDK 1.9 from the 0.28.0 version. The previous version only supports JDK
1.8.

Installation method

MaxCompute Studio is a plugin of IntelliJ IDEA, which can be installed using either of the following

two methods:

* Online installation using the plugin library (recommended)

+ Installation using a local file
Online installation (recommended)

MaxCompute Studio The MaxCompute Studio plugin has been opened for all users on the Internet
. You can install MaxCompute Studio using the official IntelliJ IDEA plugin library.

Procedure

1. Open the plugin configuration page on IntelliJ IDEA. (If you are a Windows/Linux user,
choose File > Settings > > Plugins. If you are a macOS user, choose IntelliJ IDEA >
Preferences > Plugins ).

2. Click Browse repositories... and search for MaxConmput e St udi o.


https://www.jetbrains.com/help/idea/2016.3/requirements-for-intellij-idea.html
https://www.jetbrains.com/idea/download/

3. On the MaxCompute Studio plugin page, click Install.

4. After the installation is confirmed, restart IntelliJ IDEA to complete installation.

Q Plugins
Appearance & Behavior ar
Keymap

Show: Al plugins =

Sort by: name *  Android Support

Editor 4% Android Support

[ ] [ ) Browse Repositories

¢ &
#& AntSupport
< Version Control Q- MaxCompute @) 5 | Repository: All » | | Category: All v
« N #% ANTLR v4 grammar plugin
|| ol e, Sort by: name ¥ | TOOLS INTEGRATION
| /& Bytecode Viewer 0 "
1 Languages & Frameworks 4 Byt a P8 MaxCompute T T 4 MaxCompute Studio
3+ Tools #& Copyright TOOLS INTEGRATION one day ago
4] Install
E MaxCompute Studio 74 Coverage
3 skdkk 4 downloads
Other Settings % i 2
3 o #& CVS Integration a Updated 16/10/10 0.1.0
1 #& Eclipse Integration xm%mmom Intellid products, providing development
] & EditorConfig Support for KTEALTTe.
& % GitInt i a Vender
it Integration 4
hi - 9 Alibaba Inc.
a 4 GitHub httpfwwew.alivun.com
a
a #& Gradle size
a #& Groovy 402M
E #& hgdidea
#& 118n for Java
#& IntelliLang
#& Java Bytecode Decompiler
#& JavaFxX
#& JUnit
#& Kotlin
# Lombok Plugin
Install JetBrains plugin... | Browse repusilers...\l HTTP Proxy Settings... | Manage repositories...
5 =3

Local installation

MaxCompute Studio MaxCompute Studio can also be installed in a local environment.

Procedure

1. Go to the MaxCompute Studio plugin page to download the plugin package.
2. Run IntelliJ IDEA.

+ If you access IntelliJ IDEA for the first time, a welcome page is displayed. Click Configure

and select Plugins from the shortcut menu, as shown in the following figure.


https://plugins.jetbrains.com/plugin/9193?spm=5176.doc44555.2.1.4hXBG1

MaxCompute Tools and Downloads / 2 MaxCompute Studio

IntelliJ IDEA

WVersion 2017.1.5

3¢ Create New Project
1 Import Project
= Open

¥ Check out from Version Control

& Conﬁguru Get Help «

Plugins

Import Settings
Export Settings
Settings Repository...
Check for Update
Project Defaults

If you have accessed Intellid IDEA before, choose File > Settings > Plugins to enter the

same page, as shown in the following figure.

Bl MyFirstProject - [C: hangbing.nsbildeaProj irstProject] - Intelli) IDEA 2017.1.5 oo o0
ilMEdit View Navigate Code Analyze Refactor Bulld Run Tools VCS Window MaxCompute Help |
New 3
& Open...
Open Recent

Wk ke E @ Q

Close Project

[ Project Structure... Cirl+Alt+Shift+S
Other Settings 3
Import Settings...

Export Settings...
Export to Eclipse...
Settings Repository...

 save Al Cirl+S

&% Synchronize Ctrl+Al+Y
Invalidate Caches / Restart...

Export to HTML...

K5 Print...
Add to Favorites ’
File Encoding
Line Separators »

Make Directory Read-only
Power Save Mode
Exit

16
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Settings T
T e L EE—————————m—m—m—_—————
(0. ) Plugins
 Appearance & Behavior @ ) Shows [ Al plugins = |
Keymap - - ;
’ Sort by name ~ | Android Support
 Editor " Android Support hd
Version: 10.2.2.2
m Ant Support )
 Version Control Supports the development of Open Handset Alliance Android

w Bytecode Viewer applications with IntelliJ IDEA.
» Build, Execution, Deployment .

& Copyright
I Languages & Frameworks

Coverage
» Tools = 9

» MaxCompute Studio a CVSIntegration

& Eclipse Integration
a EditorConfig

& Git Integration

a GitHub

a Gradle
m Groovy
w hgdidea

m [18n for Java

w IntelliLang

opooooDoOoOOQEQROOD

s Java Bytecode Decompiler

Check or uncheck a plugin to enable or disable it

Install JetBrains plugin... ] I Browse repositories... J \ Install plugin from disk... ]

B (] (o) [ ]

3. On the Plugins page, click Install plugin from disk..., as shown in the following figure.

Issue: 20181128 17
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Plugins - . u
@{' ) Show: | All plugins -

Sort by: name ¥ | Android Support
- Android Support s

Version: 10.2.2.2

Ant Support

= Supports the development of Open Handset Alliance Android
applications with IntelliJ IDEA.

a Bytecode Viewer
a Copyright

a Coverage

a CVS Integration

a Eclipse Integration
a EditorConfig

a Git Integration

a GitHub

a Gradle

a Groovy

a hogdidea

a [18n for Java
a Intellilang

a Java Bytecode Decompiler

cooocooOooOOoOOOODOOODDODD

m JavaFX

Check or uncheck a plugin to enable or disable it.

-

Install JetBrains plugin... ] I Browse repositories... [ Install plugin from disk... ]

o =i

4. In the displayed window, click the gray icon before a directory for navigation, find the plugin file,

select it, and click OK.

18 Issue: 20181128
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Choose Plugin File E

JAR and ZIP archives are accepted

=] D
Dy softwarelodps-studio-intellij-2.0.0-yq.zip ¥
a1t

IDEA

Java

kb

logtail_installer

>

Hide path

odpscmd_public
odpscmd_public0l
Snaglt
SwitchOmega

L T . T T T

windows-kb

apache-tomcat-7.0.77 zip
- cs843zip
| hitpd-2.2.32-x64-rL.zip

- logtail_installer.zip

odps-studio-intellij-2.0.0-yq.zip

5. Return to the Plugins page and click OK to install the local plugin.

Issue: 20181128 19



[ Plugins ﬂ
B Plug

(O\' :l Show: | All plugins ~ |

Sort by: name ¥ MaxCompute Studio

Coverage
] g Ch Restart Intelli) IDEA

a CVS Integration

a Eclipse Integration

a EditorConfig Changes in Version 2.6.2.5:

# Change: Remove limitation on service mode job submission

Git Int ti
s Drtintegranen & Bug fix DDL submission issue on public projects

. @ Feature: Support variable replacement in SQL script on
a Maven Integration submission

” di ® Feature: Table partition list and partition data preview
MaxCompute Studio ® Feature: Running job progress visualization and replay

Check or uncheck a plugin to enable or disable it.

L] GitHub Changes in Version 2.6.2.4;

n Gradle & Change: Update MaxCompute compiler version

L Groovy @ Bug fix Cant open help document in IDEA 2016 x

5 hgdidea Changes in Version 2.6.2.3;

- I18n for Java : gnga&gzment: Data preview performance

a Intellilang Changes in Version 2.5.2.2;

a Java Bytecode Decompiler & Bug fixes

a JavaFX Changes in Version 2.6.2:

a JUnit @ Feature: Unstructured data handler template and examples
. @& Feature: Support live template in SQL Editor

a Kotlin @ Feature: Support decimal type in data import/export

“

[ Install JetBrains plugin... l I Browse repositories... l ’ Install plugin from disk... ]

[ coree | [ 1o

6. After the installation is complete, a dialog box is displayed, prompting you to restart IntelliJ

IDEA. Click Restart.



Welcome to Intelli) IDEA | = bce

lntalli L IDEA

- 4
[ Platform and Plugin Updates
g

Q Restart Intelli) IDEA to activate changes in plugins?

¥ Check out from Version Control =

# Configure ~ Get Help ~

7. After Intellid IDEA is restarted, the page is displayed as shown in the following figure.

=

elcome ta

IntelliJ IDEA

—

Version 2017.1.5

1% Create New Project
¥ Impaort Project
Open

¥ Check out from Version Control ~

4 Configure ~ Get Help -




Next step

Now, you know how to install the MaxCompute Studio plugin. Continue to the next tutorial. In the
tutorial, you will learn how to configure a MaxCompute project connection to manage data and

resources. For more information, see Create a MaxCompute project connection.

2.2.3 View and upgrade the version

View the MaxCompute Studio version
Perform the following steps to view the Studio version:

1. Go to the Settings/Preferences page (by pressing Ctrl - Al t - Sin Windows or g in macOS).
2. Select Plugins on the left bar of the dialog box and search for MaxCompute Studio.

3. View the MaxCompute Studio version number and release information.

Alternatively, you can select MaxCompute Studio on the left bar of the Settings page to view

the current version number.
Check new versions

By default, MaxCompute Studio automatically detects new versions. If a new version is available,

MaxCompute Studio automatically notifies you.
After receiving an update prompt, you can select:

» Install: Click the Install link in the update prompt. The new version is automatically downloaded

and installed. After the installation is complete, restart IntelliJ IDEA.

» Configure: Click the Configure link in the update prompt. You can configure whether to detect

new versions automatically.

If the automatic update function is disabled, you can perform the following steps to check and

install a new version of MaxCompute Studio.

1. Go to the Settings/Preferences page (by pressing Ctrl - Al t - Sin Windows or g in macOS).
2. Select MaxCompute Studio on the left bar of the dialog box.

3. On the MaxCompute Studio configuration page, click Check new versions.

4

. If a new available version is detected, Studio notifies you of the new version number. Click

Install new version and restart IntelliJ IDEA to complete installation.

You can use the Automatically checks for new version check box to control the switch for

automatic version update check.



Next step

Create a MaxCompute project connection

2.3 Manage data and resources

2.3.1 View tables and UDF

View tables and functionsView tables and functions

In the Project Explorer window, you can view tables, functions, and resources with connections
added. For tables and functions to be viewed in the Project Explorer window, the MaxCompute
project connections must be added, for more information, see Add MaxCompute project

connections.
Browse tables and functions
To browse tables and functions in the project space, follow these steps.

1. Open the Project Explorer window and you can view the added Project node tree.

‘MaxCompute Project Explorer

b

+ - O T = O ?

(3] odps_studio_dev|

[H Tables & Views
[~ ] Functions
[ Resources

The toolbar is displayed at the top of the node tree, and includes:

+ Add Project: Adds a connection to the MaxCompute project space.

+ Delete Project: Deletes a connection from Project Explorer, which has no impact on the

project space on the server end.

+ Update Metadata: Updates metadata information from the project space on the server end

and updates the locally buffered metadata.
+ Expand Node: Expands all tree nodes.
* Fold Node: Folds all tree nodes.
» User Feedback: Submits user feedback.
* Online Documentation: Opens online documents.

2. Double-click the Tables node or click the drop-down arrow to expand the Tables node to list

all tables in the project (including virtual views). The table name list serves the same purpose



as the show tables command. You must have the List Table permission in the project. The

methods for the Functions and Resources nodes are similar to that of the Tables node.

P] odps_studio_dev
B=Tables & Views |
alitrip_dest_relation
array_map_test2
haoping_sdk_log_copy
haoping_test_part

] Functions

[T Resources!

3. MaxCompute Studio downloads project metadata on the server to the local device. When
metadata on the server end is updated, for example, a new table is added, you must manually
trigger a refresh to reload changed metadata to the local device. The refresh can be performed

at the Project or Table level. The procedure is as follows:

a. Select a node.

b. Click the Refresh icon on the toolbar or right-click the node and select Refresh meta.

MaxCompute Project Explorer - A\

+-[g]lz=z 002
?E odps_studio_dev
;?Ebles = Add project

alitri
PYe® | Refresh meta [

haop open specific entity
haoping_test_part
hy_testl

HH key

View table details
You can view data table information in Table Details View of MaxCompute Studio.

1. In the node tree, expand a table node to view the column name and type.



[P| odps_studio_dev
IﬁTahles & Views

F
-
F

id :STRING

hy_testl
key
table_test
[~ ] Functions

=l Resources

alitrip_dest_relation

arrays :ARRAY <STRING=
H maps :MAP<STRING,STRING=
haﬂplng sdk_log_copy
haoping_test_part

2. Double-click a table or right-click a table and choose Show Table Detail to view the table

details. The table details include metadata, such as owner, size, and column, table structure

information, and data preview.

VaxCompute P forer Bl avaethodr

&
&

K EPSHRIGERSSIR] 5 b_hour x

Table schema

b_hour

Ela 0101020223 stgcontrol_395
fE] studiotest1_testl

[ Tables & Views 1830820614534790

2016-02-18 15:20:46
2016-04-18 16:48:18
2016-08-05 10:18:33

g5098%

[ hour :STRING
[ ¢ STRING
[ d STRING
[ e STRING
[ FSTRING Sh
[ g STRING Sh

e
FE3L

g

STRING
STRING
STRING
STRING
STRING
STRING
STRING

type

comments,

Eh STRINC

e {eleelelelelelelelelelelelelel:lel

EEEEEEEEEEEEEEEEEEEE

(el el felel el el felelel effelelelel

EEEEEEEEEREEEEEEEEEE
EEEEEEEEEEEEEEEEEEEE

3. Right-click Tables & Views and select Open specific entity to display the details of the

specific table. Note that the complete table name must be specified.

If you do not have the List

permission on the project and only have the permission on a specific table, you can also view

details of the table using this method. The methods for the Functions and Resources nodes

are similar to that of the Tables node.



MaxCompute Project Explorer

+ -0 TF OD?
?ﬂ odps_studio_dev

"Func Add project

o [ Resc Refresh meta

P| wpp_ds —
%] cdo_m i Open specific entity
?ﬂ studiotest]_testl

o Open specific table %

Name:|| I

o JRE

Intellij IDEA supports searching by default. After a table is expanded, you can directly press
keys on the keyboard to perform fuzzy match.

. MaxCompute Studio also supports quick search for the table, you can use the shortcut key (
Windows: Ctrl + Alt + Shift + N, macOS: ~= + & + O) to call the navigation bar, then enter the

name of the table and press Enter.

Enter symbol name: Include non-project symbols (\X380) T

Q_hyl Q)

hy_partition_test odps_studio_dev

m_test odps_studio_dev

hy_view odps_studio _dev

You can narrow the search by using the pre-keyword (table:, function:, or resource:). For

example, to search for the function count, enter function:count.

5. To know the scripts in which the table is used, right-click the table and select Find usages.

BT " F ™ S0 %l w00 et

hytestl Add project

Find usages

Refresh table meta



View function details

1. Expand a function node under the UserDefined node of Functions to display the method
signature of this function. Double-click a function node under the Functions node. Alternatively,
double-click the source code resource of the function under the Resources node. In this case,

codes of this function are displayed.

= MaxCompute Project Explorer 8- 1+ [ JavaMethodFunction java ® g PlusHello.class x
U
F g P X . . .
t|l + — I-_T ix T Decompiled .class file, bytecode version: 50.0 (Java 6)
| t - P
| P| meta_dev 1
5 Pl 0 Ce C ecreat rom cl ile bv Intellil IDEA
fF] a_0101020223_stgcontrol_395 : Jource code fecreared Tron @ -class Tiie by dntelii) A0
= . (powered by Fernflower decompiler)
u {F] studiotest1_test1 4 I : " !
3 [ Tables & Views 5
z [ Functions 6 package myudf;
! L 7
-l x divideerror . .
» 5 8 import com.aliyun.odps.udf.UDF;
! fox myudtf 9
fxm i@ public class PlusHello extends UDF {
g fx plushello(STRING):STRING 1 public PlusHelle() {
i fx timestwo .‘g }
g 1
- [Z] Resources 14 public 5tring evaluate(String a) { return "hello" + a; }
g 17}
|- 18

@ Note:

The Java code is obtained by decompiling JAR, which is not the source code. To enable the
Python UDF to parse the signature, install PyODPS (MaxCompute Python SDK) first. Install
pip: sudo/usr/bin/python get-pip.py (Download get-pip.py from Google manually) and then
PyODPS: sudo/usr/bin/python -m pip install PyODPS. Note that the Mac operating system
has Python, which is stored in /usr/bin/python. Install PyODPS in this directory.

2. The classification under the Builtin node of Functions shows the built-in functions of the

system, expand it to display signature and double-click it to display function document.

= MaxCompute Project Explorer - 2O = JavaMethodFunction java x of, PlusHello.class x
U
g + - f_j S Decompiled .class file, bytecode version: 50.0 (Java 6)
Al E - .
B P| meta_dev 1
] — - - e rom ~1 1 v TrFallid TDEA
TE‘ a_Ol[}l020223_5tgc0ntr0|_395 ; iGUrLE ;CE}'E I;_EU??..EG' \rdC.-. a LL?SS file by Intellid IDEA
— . (powered by Fernflower decompiler)
u 'fg studiotestl_testl 4 s “ y " !
g ['F Tables & Views 5
E [ Functions 6 package myudf;
- . 7
<l x divid
» }x v de;"m a import com.aliyun.odps.udf.UDF;
J myu g9
fxm L public class PlusHello extends UDF {
g ¢ plushella(STRING):STRING 11 public PlusHello(} {
£ fx timestwo ,‘g ¥
5 1
E; URESOUTCES 14 public String evaluate(String a) { return "hello” + a; }
5 17 }
= 18



2.3.2 Import and export data
MaxCompute Studio can import local data files in CSV or TSV format to MaxCompute tables and
export MaxCompute table data to local files. MaxCompute Studio completes data import and

export by using Batch data Tunnel provided by the MaxCompute platform.
Usage instructions

* The MaxCompute Tunnel service must be used for data import and export. Therefore, the

MaxCompute project added in Studio must be configured with the Tunnel service.

» Related permissions must be granted for table import and export.
Import data

1. Open the Project Explorer window, right-click a table name or a field attribute in Data preview

of Table details and select Import Data Into Table.

?E odps_studio_dev
[@Tables & Views
FFEH alitri p_dest_relation
array_map_test2
haoping_sdk_log_copy

haoeing_test_part

ke Add project

EH tal Refresh table meta
[ Functi Show table details

[T Resou

“]’E wpp_dev Delete table from server

?ﬂ_ cdo_meté Generate select statement

{P] studiotes, -
| Import data into table |

Export data from table

2. In the Import Data dialog box that appears, select the path of the imported data file, column

separator, size limitation, and number of lines for an error tolerance, and click OK .

?E odps_studio_dev
[@Tables & Views

FFEH alitri p_dest_relation
array_map_test2
haoping_sdk_log_copy

haoeing_test_part

ke Add project

- tal Refresh table meta
Functi .
I Resou Show table details

“]’E wpp_dev Delete table from server

?ﬂ_ cdo_meté Generate select statement

{P] studiotes, -
| Import data into table |

Export data from table

3. If Import Data Success is displayed, data import is successful and imported data can be

viewed in the table.



Export data
1. Two methods are provided for table data export.

Right-click a table name and select Export Data From Table.

=+

[

—
ry

©o?

)

?E odps_studio_dev
[@Tables & Views
= alitrip_dest_relation

haoping_test_part

ke Add project

.... tal Refresh table meta
Functi .
fe adc Show table details
fx ex2 Delete table from server

frhac Generate select statement
fx hac
fx hell Import data into table

EEsEl Export data from table

Ry

Right-click a field attribute in Data Preview of Table details and select Export Data From

Table.
shy_testl % |
Table information : Table schema
key value name type comments
Name: hy_testl Alid BIGINT
Comments: “|[name STRING
Owner: ALIYUNSdxp_06894684@aliyun.com | jace BIGINT

Created time:
Meta Madified time:
Data Modified time:

2016-12-29 11:50:22
2016-12-29 11:50:22
2017-01-22 20:42:37

Size: 1280
Physical size: 3840
Partitions: 0
Partition columns
Sharding:
Sharding columns:
Data preview
id
1 a

Export data from table " 11 age ‘
Import data into table

2. In the Export Data dialog box that appears, select the path for saving the exported data file,

column separator, size limitation, and number of lines for an error tolerance, and click OK.



=+

)

?E odps_studio_dev
[@Tables & Views
iE alitrip_dest_relation
HH array_map_test2
HH haoping_sdk_log_copy

k2 haoﬁing_test_part

i ke Add project

H tal Refresh table meta
Show table details

3]

[~} Functi
fxadc
fx ex2 Delete table from server

fehac Generate select statement
fx hac

fx hell Import data into table
IR Export data from table

Ry

3. If Export Data Success is displayed, data export is successful and exported data can be

viewed in the target file.

You can also right-click Data Preview of Table and choose Export Grid Data to export data.

ahy testl x ‘

Table information

} Table schema

key value

1

View cell text

@ Note:

Copy cell content

Export grid data

name type comments

Name: hy_testl id BIGINT

Comments: name STRING

owner: ALIYUN$dxp_06894684@aliyun.com age BIGINT

Created time: 2016-12-29 11:50:22

Meta Modified time: 2016-12-29 11:50:22

Data Modified time: 2017-01-22 20:42:37

Size: 1280

Physical size: 3840

Partitions: 1]

Partition columns

Sharding:

Sharding columns:
P
Data preview

id name age

1 a 11

The Data Preview function in Data preview is used only to export data displayed in Data sample

instead of all data in the table.

New Type Import Export

Simply generate text in the agreed format and store it in CSV or TSV format, you can import to

table through studio.

Conversion rules for each data type are described in detail below.

Basic Type

1. Tinyint, smallint, Int, bigint is stored directly as an integer string, and the numeric value exceeds

the type boundary is reported as wrong



2. Float, double to store fractional strings or floating-point forms, such as: 2.342 1x + 7

w

Varchar is stored directly as a string, which is automatically truncated above the upper limit,

and no errors will be reported
String is stored directly as a string
Decimal string that supports shaping or floating-point

Binary needs to encode binary data to base64 string

N o o &

Datetime date time requires that the format specified in import dialog is consistent and that the
format mismatches will be reported incorrectly

8. Timestamp timestamp needs to follow yyyy-[m] M-[d] d hh \: mm \: ss [. f...] Format is stored as
a string

9. Boolean true or false string?
Composite Type

1. Array needs to be stored as a JSON array. The array elements are converted to strings
according to the rules agreed in this article, array elements support any type.

2. Map needs to be stored as a JSON object, and map key, value are converted to a string
according to the rules agreed in this article, value supports any type of nesting.

3. Struct needs to be stored as a JSON object, the struct field name is string, and the key
converted to a JSON object, strect field values converted to JSON The value of the object, the

value of the field that defines the rule transformation in this article.
Example
Array type

For Table structures as follows:

Column name Column data types
c_1 ARRAY<TINYINT>

c 2 ARRAY<INT>

c_3 ARRAY<FLOAT>

c_4 ARRAY<DATETIME>
c 6 ARRAY<TIMESTAMP>
c 7 ARRAY<STRING>




You can import data in the CSV format shown below:

c1lc 2,c 3,c_4,c 6,c 7

reetar o, ot gt e, o2, 3, "4t [t ota.2t ottt 2.
o""1 ", "[" "3-00:00:00", "3-5-00:00:00 "", "00:00:00", "[" At 00:00:
00. 123456789 "", "At 00:00:00. 123456789 "", "At 00: 00:00. 123456789
"ttt ["AAAT ", " Steanboat "', "4C' "]"
et 1 B e I I A 2 B A e 1 2 ""2.0
" "[""2017-11- 11 00: 00: 00"" 2017 11- 11 00: 00 00" 2017 11-11
00: 00 00" “] " [ ""2017-11-11 00 00: 00. 123456789" ", "" 2017 11 11 00: OO 00
.123456789" "2017-11-11 00: 00: 00. 123456789""]","[" " aaa" "bbb""
ccc" "1
et 1“ B I e A e I 7 0
"t1t,"[""2017-11-11 00:00:00"",""2017-11- 11 00: 00 oo"",""2017-11-11
00: OO 00" "] " [ ""2017-11-11 00: 00: 00. 123456789"",""2017-11-11 00: 00: 00
.123456789" "2017-11-11 00: 00: 00. 123456789""]1","[""aaa"", ""bbb"", ""
ccc" "1
Note:

The CSV format needs to escape double quotes, which are expressed by two double quotes, you

can refer specifically to the CSV format specification.
Map Type

For Table structures as follows:

Column name Column data types

c_1 MAP<TINYINT,STRING>

c 2 MAP<STRING,INT>

c 3 MAP<FLOAT,STRING>

c_4 MAP<STRING,DATETIME>
c_5 MAP<STRING,STRING>

c 6 MAP<TIMESTAMP,STRING>

You can import data in the CSV format shown below:

c l,c 2,c 3, c4,c5cb6

"{1:" "2345" "}, "{" 123 "": "2", "3": "4 ""}",  "{2.0:" "223445"

II, 1. 2: n llll n Il}ll, II{II n AAAII n : n n hubll 00 00 OO n II, n 4Cl n : n G.]i na
"11 00:00: 00" "," Steanboat "": 00 00.00 Pt ckey "": "cval ue"}
“," {"" hubll 01:00: 00. 123456789 "": "dddd" "," "hubll 00: 00: 00.
123456789 "t "AAAT MM 027 11 00: 01 00 123456789 " "DDD e
"{1:" "2345" "}, "{" 123 "": "2", "3": "4 ""}",  "{2.0:" "223445"

Il’ 1. 2: n 1111 n |I}ll’ Il{ll n AAAI! Il: n n hubll 00: 00: OO n |I, n 4Cl n : n G.]i na
"11 00: 00: 00" "," Steamboat "": "00:00:00"} "," ckey "": "cval ue"}
"," {"" hubl1l 01:00: 00. 123456789 "": "dddd" "," "hubll 00: 00: 00.

123456789 nn ; n AAA" " , n 027 11 OO 01: 00 123456789 nun : 1] m) [TI1] } 1]




"{1:""2345" "}, {123 o2, 3o rt4n " {2.0:""223445"" 1. 2

S"w11117"} ", "{""aaa"": ""2017-11-11 00: 00: 00"", ""ccc"": ""2017-11- 11
00: 00: 00" ", ""bbb"": ""2017-11-11 00: 00: 00""}","{""ckey"": ""cval ue
et m{vv2017-11-11 01: 00: 00. 123456789"": ""dddd" ", ""2017- 11- 11 00: 00:

00. 123456789"": ""aaa"", ""2017-11-11 00: 01: 00. 123456789"": ""ddd""}"

Struct Type

For Table structures as follows:

Column name Column data types

C_struct <RUCT<x:INT,y:VARCHAR(256),2:STRUCT<a
:TINYINT,b:STRING>>

You can import data in the CSV format shown below:

c_struct
n { nn XII n : nn 1000" n , mn yII n : nn Var Char _t eSt mn , nn ZII n : {II n a.ll n : mn 123" n , man bll n : nn

stringdenp""}}"
n { mnn XII n : mn 1000" n , mun yll mn : mn Var Char _t est mun , mn ZII n : {II n a.ll n : mun 123" n , mun bll mn : mn

stringdeno""}}"

2.3.3 Visualization of operating the tables

The Project Explorer of MaxCompute Studio provides the visualized table structure editor used to

create and modify tables.
Visualization of creating a table

Procedure

1. Right-click the project that you want to create the table, and select create a new table:

Project Explorer

=+

» {P] hntest
L J 'i dataplus nrivate tect A
» [ Table Add project

v [AFunc Remove project

» FRU
» Fgs Refresh meta

» [Z)Resc Show|Modify project properties
[ 2 'E_ autotesi Open in Console

Create a new table




2. In the dialog box that appears, enter a table name and column information. Click Generate
CreateTable Statement generates the corresponding pant statement, click Execute to

execute the build table.

® [ ] Table Creation Editor - [project : dataplus_private_test_4]

Columns:

Generate CreateTable Statement

~id"

Copy to Clipboard Execute

When you set the table name, column name, type, and lifecycle, observe the related

requirements of MaxCompute. For more information, see Table Operations.
3. After the table is created, view the table metadata in table&view of the Project Explorer. If no

metadata is displayed, refresh the list.
Visualization of modifying a table
Procedure

1. In table&view of the Project Explorer, right-click the expected table and select Open table

Editor:



)

ha

e :
[F] hgtest_0718
hgtest_1228
B ji™biaoshijia
B i gu

] jienu2

B jir yyan_wc_i

B jin van_mc_o
EE kcWre_filc_t
Knggw_gpint_:

Bl knumv, moint_k
B8 knd Jpoint_t
EH knog _point_c
FH lakmropaga
B8 It selp. waga
abelprommga

Add project
Find u
Open table editor

Refresh table meta

Show table details

e select statement

Generate DDL statement

Truncate table data

Drop table from server

Import data into table

Export data from table

2. In the dialog box that appears, edit the table. You can modify the table comments, table
lifecycle, column name, and column description, and add columns. Specific rules follow the

MaxCompute table requirements and can be found inTable Operations.



[ ] @ Table Editor - [dataplus_private_test 4.hgtest 0718]

AlterTable Statement CreateTable Statement
AlterTable Statement

Copy to Clipboard Execute

3. After completing the modifications, click Alter Table Statement Generate a specific alter
statement and click Executeto perform the table modify operation. After successful execution,

view the table metadata.
Visualization of deleting a table

In table&view of the Project Explorer, right-click the expected table and select Drop table from

server:



Project Explorer

s & Views
n rata
Add project

Find us
Open table editor

Refresh table meta

Show table details

| 3
%
%
>
%
%
>

[ 3
Cd Func
F#lReso Generate DDL statement

Generate select statement

Truncate table data
Drop table from server

Import data into table
Export data from table

Select OKin the bullet box to remove the table from the maxcompute service.

2.4 Developing Java

2.4.1 Create MaxCompute Java Module
MaxCompute Studio supports Java user-defined function (UDF) and MapReduce development.

First, a MaxCompute Java module must be created.
Create a module

Choose Fil e > New > Modul e, set the module type to MaxConput e Java, and configure
Java JDK. Click Next, enter a module name, and click Finish. MaxCompute Studio

automatically creates a Maven module and introduces MaxCompute dependencies.

Module structure

So far, a module for developing a MaxCompute Java program has been established, that is the

mDev shown in the following figure. Its main directories include:

* src/main/java: Source code for Java program development.



+ examples: Sample code, including unit test (UT) examples. You can see the examples to
develop or compile UT.

» warehouse: Schema and data required for running locally.



Project v O = | & I-
. studioTest ~/IdeaProjects/studioTest
.idea
mdev
examples
com
aliyun
odps
examples
mr
udf
unstructured
src
main
java
resources
test
target
= Mdev.iml
. opomxm
scripts
warehouse
example_project
__resources__
__tables__
rs_out
wc_in1
= _ schema__
data
wc_in2
wc_out
= StudioTest.iml
Il External Libraries



2.4.2 Develop and debug UDF

Once the MaxCompute Java Module has been created, udfs can be developed.
Procedure
1. Expand the MaxCompute Java Module Directory that you created and navigate to src > main >

java > new, and click MaxCompute Java as shown in the following figure.

studio [V

Project

studio

.idea Copy Path

java_m Cobv Reference g . €
opy Reference :
EEY T ey o FXML File
P ey 'PF_'QSTE - 4 ) . .
¥ 5rc : ge-info.java
main ,
— Ve o ..~ & MaxCompute Java
JEN% Find in Path... G8F o = o
> T~ i — A StR 2 MaxCompute SQL BZ
: eplace in Path... O+ ;
B : HTML File
3 .
= resources JavaFXApplication
. Refactor Singleton
target XSLT Stylesheet
| java_m.iml Add to Favorites
pom.xmi Show Image Thumbnails (3 Edit File Templates...
myprj

2. Set Name and Kind, and click OK. as shown in the following figure.

0] @ Create new MaxCompute java class
Name: @ MyFirstUDF

Kind: | [ UDF
[ uDF

UDAF

UDTF

o” Driver

m* Mapper

R¥ Reducer
StorageHandler
Extractor

» Name: Specifies the name of the MaxCompute Java Class. If you have not created a
package, you can enter packagename.classname to automatically create a package.

+ Kind: Specifies the type. Supported types include custom functions (UDF/UDAF/UDTF),
MapReduce (Driver/Mapper/Reducer), and non-structural development (StorageHandler/

Extractor).



3. After the creation is successful, the Java program can be developed, modified, and tested.

B Project - | MyFirstUDF.java
v studio hg_udf
> .idea
v java_m

com.aliyun.odps.udf.UDF

resources

[% Note:

Here's a code template that can be customized in Intellij. You can define it in Preference >

Editor > File > Code Templates. Then look for the corresponding template in the Code tab.
For detailed development steps, seeJAVA UDF development.
Normally, the development of JAVA UDF can be done in the following ways:

+ Use MaxCompute Studio to complete the whole process of JAVA UDF development.
» Use Develop and debug JAVA UDF using the Eclipse plug-in, export the Jar package, then

Add resources through commands or DataWorks, and Register the function.
For detailed development steps, seeJAVA UDF Development.
Debug the UDF program

After the UDF program is developed, it can be tested using unit test (UT) or local running to check
whether it meets expectations.

Unit Testing

There are various UT examples in the examples directory and you can refer to them to compile

your UT.



o - PE—

v studio y xamples. udf.test
> .idea
v java_m
UDFTest {

simpleInput()
r runner
Objectl] {

UDFTest
m

from History...
Paste Simple
Column Selection Mode

Refactor

src
target

I java_m.iml
pom.xml inp i ) )y { Go To

myprj QU Generate

table, partition Search with Google

Recompile 'UDFTes!
Run 'simplelnput()*
Debug 'simplelnput()’
% Run 'simpleinput()* with Coverage

Run locally

During local running of the UDF program, the running data source must be specified. The

following two methods are provided to set the test data source:

+  MaxCompute Studio uses the Tunnel Service to automatically download table data of a specific
project to the warehouse directory.
* The mock project and table data are provided. You can see example_project in warehouse to

set it by yourself.
Procedure

1. Right-click UDF Class and select Run UDF class.main(). The Run Configuration dialog box
is displayed. In normal cases, UDF/UDAF/UDTF data is used as columns in tables of a select
sub-statement. The MaxCompute project, table, and column need to be configured. (The
metadata is from the mock project under project explorer and warehouse.) Debugging for

complex types is also supported, as shown in the following figure:



MaxCompute

Tools and Downloads / 2 MaxCompute Studio

Environment variables:

. Run/Debug Configura‘tipasb - ‘ P ‘
=+ Em W % + Name: | PlusHello | [] Share [ ] Single instance only
> [&]JUnit Main class: | myudf.PlusHello ‘\:‘
¥ ‘A MaxCompute Java

XUDAFF_xampIe VM options: | |
X
hello
el Program arguments: | |
» A MaxCompute SQL Working directory: | H - H ] |
» % Defaults |

Use classpath of madule: l = java_module_learn

JRE:

- [ Enable capturing form snapshots

FMaxCDmpute project:| odps_studio_dev

-]

l Default (1.8 - SDK of ‘java_module_learn’ module)

B
- I

- [

|"MaxComputetabIe: hy_testl
ETabIe columns: name |ie:c1,c2

~ Before launch: Build, Activate tool window

41 Build

[ Show this page Activate tool window

m I Cancel I [ Apply ] I Help I

2. Click OK.

B Project v
» Bout
» [scripts
» [rarget
v [warehouse
v [meta_dev
v [J__tables__
v [Jhy_test

Bl __schema__

[&studioTest.iml

» WhExternal Libraries

Run

4
|

PlusHello

@8 2= + ¥+ »
_ Test framework quit unexpectedly

Note:

(%] - 1

ahy_test x  Bstudiotestl.osql %
package myudf;

import com.aliyun.odps.udf.UDF;

© PlusHellojava % = (c% UDFTestjava %

public class FlusHello extends UDF {
// TODO define parameters and return type, e.g:
public String evaluate(String s) {
return "hello world:" + s;

public §

public String evaluate{Long a, String b) {
return "hello world2:" + a + " " + b;
H

/Library/Java/JavaVirtualMachines,/jdkl.8.0_65. jdk/Contents/Home/bin/java ...

Testing started at 15:02 ...

[INFO]Start to write table scheme : meta_dev.hy_test-->/Users/liuyi/IdeaProjects,
[INFOlgenerate schema file: /Users/liuyi/IdeaProjects/studicTest/warehouse/meta,
[INFO]Finished to write table scheme : meta_dev.hy_test—-=/Users/Lliuyi/IdeaProj¢
[INFO]Start to download table: 'meta_dev.hy_test', download mode:AUTO
[INFO]Tunnel DownloadSession ID is : 20160930150300d492b70aB81854c05

[INFO]Start to write table: meta_dev.hy_test=-»/Users/liuyi/IdeaProjects/studic
[INFO]Finished write table: meta_dev.hy_test--=/Users/liuyi/IdeaProjects/studic
hello world2:1 a

hello world2:2 b

hello world2:3 c,d

Process finished with exit code @

Issue: 201811

28

43



» |f the table data under the specified project is not downloaded into glashourse, You need

to download the data first, default download 100 entries. If more data is required, use the

Tunnel Command of the console or table downloading function of Studio.

» If the mock project is used or the table data is downloaded, directly run the program.

» The UDF local run framework uses data in specific columns in warehouse as the UDF

input and run the UDF program locally. You can view log output and result display on the

console.

Local warehouse directory

The local warehouse directory is used to store tables (including meta and data) or resources for

local UDF or MR running. The following figure shows the warehouse directory.

51 Project v @ = | ¥~ 1

sandbox ~/ldeaProjects/sandbox
.idea
jDev
out
scripts
target
warehouse
example_project
__resources__
__tables__
rs_out
wc_inl
__schema__
data
wc_in2
pl=1
pl=2
= __schema__
wc_out

Note:

__schema__

project=example_project
table=wc_inl
columns=coll:STRING, col2:STRING, col3:STRING, col4:STRING

* The project name, tables, table name, table scheme, and sample data are under the

warehouse directory in sequence.

» The schema file is configured with the project name, table name, and column name and type (

separated using a colon) in sequence. For a partition table, the partition column also needs to

be configured. (For a non-partition table, refer to wc_in1. For a partition table, refer to wc_in2).

* The data file uses the standard CSV format to store table sample data.

— Special characters include comma, double quotation marks, and line feed (\n or \r\n).

= The column separator is comma and the line separator is \n or \r\n.



— |f the column content includes special characters, double quotation marks () must be
added before and after the column content. For example, if the column content is 3,No, it is

changed to “3, No”.

== |f the column content includes double quotation marks, each double quotation mark is
converted to two double quotation marks. For example, if the column content is a’b”c, it is

Changed tO “a””b””C”.

— \N indicates that a column is null. If the column content (string type) is \N, it must be

converted to “””\N”"”.

— The file character code is UTF-8.

2.4.3 Develop MapReduce

After the MaxCompute Java module is created, MR can be developed.
Develop the MR program

1. Right-click the module source code directory src > main, select New, and select MaxCompute

Java.

2. Create Driver, Mapper, and Reducer.

'® @ Create new MaxCompute java class
Name: | !

Kind: & Driver o
Cancel [Nl

3. Set the input/output table and Mapper/Reducer class. The framework code is automatically

filled in the template.


SP_76/DNODPS1857765/EN-US_TP_12129.dita
SP_76/DNODPS1898901/EN-US_TP_12013.dita

¢’ HelloDriver java
HelloDriver

package mymr.myudf;

import ...

delic class HelloDriver {
public static void main(String[] args) throws OdpsException {
JobConf job = new JobConf();

// TODO: specify map output types
job.setMapOutputKeySchema(SchemaUtils. fromString(_?));
job.setMapOutputValueSchema(SchemaUtils. fromString(_?));

// TODO: specify input and output tables
InputUtils.addTable(TableInfo.builder().tableName(_?).build(), job);
OutputUtils.addTable(TableInfo.builder().tableName(_?).build(), job);

// TODO: specify a mapper
job.setMapperClass(_?);
// TODO: specify a reducer
job.setReducerClass(_7?);

RunningJob rj = JobClient.runJob(job);
rj.waitForCompletion();

For details of developing MR, seeTo write MapReduce.
Debug the MR program

After the MR program is developed, test your code and check whether it meets the expectations.

The following two methods are supported:

Unit test (UT): There are WordCount UT examples in the examples directory. You can refer to

them to compile your UT.



v @ =  #- I= (€ wordCountTestjava X

9x ~/ldeaProjects/sandbox WordCountTest || WordCountTest()
a package com.aliyun.odps.examples.mr.test;
v
axamples +import ...
com.aliyun.odps.examples

»»  public class WordCountTest extends MRUnitTest {

mr 21 // BXBNBEER schema
test private final static String INPUT_SCHEMA = “a:string,b:string";
¢’ WordCountTest 3 private final static String OUTPUT_SCHEMA = “k:st _
> | private JobConf job; Copy Reference Xraec
c Resource ! =
¢ % WordCount 0 { [F¥ Paste #V
26 public WordCountTest() throws Exception Paste from Histor 098V
udf 2 /] EEELRE : v -
sre job = new JobConf(); Paste Simple N4 8V
com Column Selection Mode 38
M job.setMapperClass(WordCount.TokenizerMapper.cl
€ = MrTest job.setCombinerClass(WordCount.SumCombiner.clas  pafactor >
Dev.iml job.setReducerClass (WordCount.SumReducer.class)
ts job.setMapOutputKeySchema(SchemaUtils. fromStrin Folding >
P job.setMapOutputValueSchema(SchemaUtils. fromStr Analyze >
>dps_studio.haoyi ‘
1ello.py InputUtils.addTable(TableInfo.builder().tableNa Go To »
myudaf.py ¢ ) OutputUtils.addTable(TableInfo.builder().tableN Generate... %N
.qloptmizer.osql
«osql @SuppressWarnings (“deprecation”) Recompile 'WordCountTest.java' 0 ¥F9
r.osql R @TEiF » wan() th 108 ) . Run 'WordCountTest' ~{R
.+ osal > public void testMap() throws xception, ClassNo o , .
0sq } MapUTContext mapContext = new MapUTContext(); § Debug 'WordCountTest ~4D
let 5 mapContext.setInputSchema(INPUT_SCHEMA); ¥ Run 'WordCountTest' with Coverage
p € mapContext.setOutputSchema(OUTPUT_SCHEMA, job);
ehouse /7 R EOE ., [@ Create 'WordCountTest'...

Local MR running: During local running, the running data source must be specified. The following

two methods are provided to set the test data source:

»  MaxCompute Studio uses the Tunnel Service to automatically download table data of a
specific MaxCompute project to the warehouse directory. By default, 100 data records are
downloaded. If more data is required for testing, use the Tunnel Command of the console or
table downloading function of MaxCompute Studio.

* Provide the mock project (example_project) and table data. You can see example_project in

warehouse to set it by yourself.

1. Run the MR program. Right-click the Driver class and select Run. In the displayed Run

Configuration dialog box, configure the MaxCompute project on which the MR program runs.



[ BON ] Run/Debug Configurations

+ -0 H % v Name: |WordCount Share Single instance only
‘A MaxCompute Java

WordCount Main class: com.aliyun.odps.examples.mr.WordCount

UDFExample VM options:
Resource
2 MaxCompute Python Program arguments:
A MaxCompute SQL
% Defaults Working directory:

Environment variables:

©

Use classpath of module: jDev

<>

JRE: Default (1.8 - SDK of 'jDev' module)

Enable capturing form snapshots

*MaxCompute project: example_project u +

v Before launch: Build, Activate tool wind ow
44 Build

Show this page Activate tool window

? Cancel [ OK |

2. Click OK. If table data of the specified MaxCompute project is not downloaded to warehouse,
download data first. If a mock project is used or the MaxCompute project table data is
downloaded, skip this step. Then, the MR local run framework reads specified table data in
warehouse as the MR input and runs the MR program locally. You can view log output and

result display on the console.

Run /. WordCount

» /Library/Java/JavaVirtualMachines/jdk1.8.0_65.jdk/Contents/Home/bin/java ...

[INFO]Run mapreduce job in local mode, Type: MR, Job ID: mr_20170221193325_750_3935

[INFO]Start to process input tables

. [INFO]Start to copy table: example_project.wc_inl-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_inl
= [INFO]Finished copy table: example_project.wc_inl-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_inl
[INFO]Start to copy table: example_project.wc_in2{p1=2, p2=1}-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_in2
[INFOIFinished copy table: example_project.wc_in2{pl=2, p2=1}-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_in2
[INFO]Finished process input tables

[INFO]Start to process output tables

[INFO]Start to write table scheme : example_project.wc_out-—>/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__
[INFO]generate schema file: /Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__/__schema__

[INFO]Finished to write table scheme : example_project.wc_out-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__
[INFO]Finished process output tables

[INFO]Start to process resources

[INFOIFinished process resources

[INFO]Start to fill tableInfo

[INFO]Finished fill tableInfo

[INFO]Start to validate configuration

[INFO]Finished validate configuration

[INFO]Start to run mappers, num: 2

[INFO]Start to run mapper, TaskId: M_000001, Input: example_project.wc_inl

[INFO]Start to run Combiner, TaskId: M_000001

[INFOIFininshed run Combiner, TaskId: M_000001

[INFO]Fininshed run mapper, TaskId: M_000001, Input: example_project.wc_inl

[INFO]Start to run mapper, TaskId: M_000002, Input: example_project.wc_in2{pl=2, p2=1}

% 3
e o @

~ X

Run the MR program in the production environment

After local debugging is complete, release the MR program to the server and run it in the

MaxCompute distributed environment.

1. Package the MR program to a JAR package and release it to the server. For more information

, See How to package and release MR.


https://www.alibabacloud.com/help/doc-detail/50904.htm
https://www.alibabacloud.com/help/doc-detail/50904.htm

2. Use the MaxCompute console integrated with MaxCompute Studio in seamless mode, that is,
in the Project Explorer window, right-click Project and select Open in Console, and input the

commands similar to the following JAR command in the console command line:

jar -libjars wordcount.jar -classpath D:\odps\clt\wordcount.jar com
al i yun. odps. exanpl es. nr. WordCount wc_i n wc_out;

2.4 4 Unstructured development
An unstructured data processing framework is added for MaxCompute 2.0, supporting access
to the OSS and Table Store using external tables. Studio provides some code templates for the

framework, facilitating users' fast development.
Compile StorageHandler/Extractor/Outputter

1. After the MaxCompute Java Module (Sample code is provided in the unstructured folder of the

examples directory for your reference).

2. Right-click the module source code directory src > > main, select new, and select

MaxCompute Java.

3. Specify Name and Kind. For example, set Name to myun.MyExtractor and Kind to Extractor.
Click OK.

®  ©® Create new MaxCompute java class

Name: @ myun.MyExtractor Tl

Kind:  Extractor u

? Cancel SIS

4. The framework code has been automatically filled in the template. Compile your logic code.

5. Compile Outputter and StorageHandler by following the preceding steps.
Unit Testing

You can compile the unit test (UT) by following the examples in the examples directory to test your

Extractor/Outputter.


SP_76/DNODPS1898901/EN-US_TP_12017.dita

Project - D = B I < ExtractorTest.java

e St“theSt ~[ldeaProjects/studioTest ExtractorTest || ambulanceFullSchema
:ldea 3 +import ...
iidev 18 -
examples 19 G plolic class ExtractorTest {
com.aliyun.odps.examples 20 private StrilMIEITTEIITFullSchena =
21 "vehicle:bigint;id:bigint;patient:bigint;calls:bigint;latitude:dc
mc;f 22 private String speechDataFullSchema = "sentence_snr:double;id:string'
u 23
unstructured 24 @Test
test 25 G public void testTextExtractor() throws Exception {
26 VESS
4 ExtractorTest 27 * Equivalent to the following SQL:
c OutputerTest 28 CREATE EXTERNAL TABLE ambulance_data_external
¢ SpeechSentenceSnrExtractor.jave 29 ( vehicle bigint, id bigint, patient bigint, calls bigint,
30 Latitude double, Longitude double, time string, direction string)
< Sheschetorageliandiey 31 STORED BY 'com.aliyun.odps.udf.example.text.TextStorageHandler'
¢ ' TextExtractor 32 LOCATION ‘oss://.../data/ambulance_csv/"
c TextOutputer 33 USING 'jar_file_name.jar';
¢  TextStorageHandler 34
. 35 SELECT % FROM ambulance_data_external;
¢ = TestUtil 36 */
data 37 Column[] externalTableSchema = UnstructuredUtils.parseSchemaString!(

Package and upload

After StorageHandler/Extractor/Outputter is compiled, compress the completed Java program to a

JAR package, and upload the package as a resource to the server, see Package and release.
Create External Table

1. Right-click scripts and select new > MaxCompute Script.

box ) scripts ) € Java Class
roject ¢ Kotlin File/Class

ssandbox ~/Id & Cut #X = File
idea i Copy e = Scratch File 8N
Lijdev Copy Path 7+ 8C Package
out Copy as Plain Text EXML File
scripts ‘ Copy Reference YO%C | . . .
odps_st! [l paste sey | package-info.java

) _Init_§ £ MaxCompute Java
mabcm]  Find Usages o
FJmeta_de  Find in Path...  $6F T F” .
EJodps_stt  Replace in Path... ORR | EXApplicati
FJosd.osql - 3 Java pplication

= ParseCol s Singleton
EJtmp.osql Refactor B o XSLT Stylesheet

2. Enter the SQL script name. Select the MaxCompute project in which the script is to be
executed for Target Project and click OK.
3. Select create external table live template in the editor to rapidly insert the script template for

creating an external table.


https://www.alibabacloud.com/help/doc-detail/50904.htm

q

et create external table _
t create table
tl create table like
ts create table as select
v create view

~¥ and ~ 1 will move caret down and up in the editor >> I8

Modify the external table name, column, type, StorageHanlder class path, configuration
parameter, external path, and JAR name. Click Run MaxCompute SQL Script to create the

external table.

4. Query the created external table, such as:

2.4.5 Package/Upload/Register

After a user-defined function or MapReduce is developed, you must package and release it to the

MaxCompute system.
Package a UDF or MapReduce

To release a UDF or MapReduce to the MaxCompute server for production use, you must
complete packaging > uploading > registration in sequence. You can use the one-click
release function to complete these procedures. MaxCompute Studio runs the mvn clean package
command, uploads a JAR package, and registers the UDF in one stop. To use this function, right-
click the UDF or MapReduce and select Deploy to server.... Make sure that the target class is

in the src > main > java subdirectory and is successfully compiled on the Maven module. The
dialog box shown in the following figure appears. Select the MaxCompute project to be deployed
and enter a resource name and a function name. Click OK and wait until the operation in the

background is complete.


SP_76/DNODPS1857765/EN-US_TP_12130.dita
SP_76/DNODPS1857765/EN-US_TP_12131.dita

[ NON | Package a jar and submit resource

*MaxCompute project: meta_dev ﬁ +
*Resource name: jdev-1.0-SNAPSHOT.jar
*Main class:| myudf.TestHello

*Function name:

Force update if already exists

? Cancel ﬁ

@ Note:

If you require special packaging, you can modify relevant settings in the pom.xml file. After

packaging, follow these steps to upload the JAR package and register the UDF.
Upload the JAR package
After the JAR package is prepared, upload it to the MaxCompute server.
1. Select Add Resource from the MaxCompute menu.

Ll Open Logview

" Add Resource |

f» Create Function

2. Select the MaxCompute project you want to upload the resource to, the JAR file path, and the
resource name you want to register. Determine whether to force update when the resource or

function already exists. Then click OK.



e © Add Resource
Add Resource meta_dev
*Resource file: [out/artifacts/haoyitest/haoyitest.jar

*Resource name: haoyitest.jar

Force update if already exists

carcel (KT

3. After uploading is successful, you can view the resource under the Resources node of the

Project Explorer window.

MaxCompute Project Explorer 8- 1=
+ - 3: % T
7P| meta_dev
- & Tables & Views
- [~ Functions

[ Resources
& haoyitest.jar (23769B)

Register the UDF
After the JAR package is uploaded, register the UDF.
1. Select Create Function from the MaxCompute menu.

VeS  Window Help

leaProjects/studi¢ [ Open Logview
'] Add Resource

Create Function

2. Select the required resource JAR and JAR main class, and enter the function name. Click OK.



MaxCompute Tools and Downloads / 2 MaxCompute Studio

| ® @ Create Function

*MaxCompute project: meta_dev

*Function name: | plushellg|

Getlnstanceld.jar

getprojectfromworkerpath.py
*Using resources: |getUserCommandUDF.py
qunz64.py

*Main class: Myudf.PlusHello

Force update if already exists

cancel (TSNS

3. After the registration is successful, you can view the function under the Functions node of the

Project Explorer window.

L 4 meta_ dev

» [ Tables & Views
v [ Functions

» fx plushello

> fxs52s
» [Z}Resources

Apply the UDF

* Apply the UDF in SQL to complete subsequent development.

Em.osal x

! 0wy meta_dev

am n
author:liuyi

——create time:2016-10-12 18:22
A eek2 .0 Settingrrrrrtrtarr—

—-set odps.sql.planner.parser.odps? = true;

—-set odps.sql.planner.mode = "lot";

—-set odps.sql.preparse.odps2 = "lot";

—-set odps.compiler.output.format = "lot,pot";

—-set odps.sql.runtime.mode = "executionengine";

—_ ek ——

P Surround with ()
plushello(STRING) (UDF Function)
PARSE_URL(STRING,STRING) | tin Function) STRING
PERCENT_RANK() (Builtin Function) DOUBLE
PI{) (Builtin Func DOUBLE
PMOD (DECIMAL ,DECIMAL) Ltin Function) DECIMAL
POSITIVE(T) (Buillir T
POW(DOUBLE ,DOUBLE) (& 1 iction) DOUBLE
POWER(DECIMAL,DECIMAL) (Euiltin Function) DECIMAL
PRINTF(STRING,ANY) (Builtin Function) STRINC

MAV DT/CTDTMEN (Boil+in Eimctinn cTo T
Press ~.to choose the selected (or first) suggestion and insert a dot afterwards 2> T

54 Issue: 20181128



2.4.6 Develop Graph

After the MaxCompute Java module is created, Graph can be developed.

Sample Code

There are some code examples of Graph in the examples directory, and you can refer to the

example to get familiar with the structure of the Graph program.

[ Project > D = | B 1
“\ sandbox ~/ldeaProjects/sandbox
.idea
= graph
examples
com.aliyun.odps.examples
graph
¢’ Kmeans
¢" PageRank
¢” SSSP
mr
udf
unstructured
¢ TestUtil
data
src
target
= graph.iml
m pom.xml

Develop a Graph Program

4 PageRank.java

2

+import ...

/%%

* Set program arguments:
a4 pagerank_in pagerank_out
*

*/
> public class PageRank {
public static class PageRankVertex extends
Vertex<Text, DoubleWritable, NullWritable, DoubleWritable> {
@Ooverride
) public void compute(ComputeContext<Text, DoubleWritable, Nullwr

Iterable<DoubleWritable> messages) throws IOException {

if (context.getSuperstep() == 0) {
setValue(new DoubleWritable( value: 1,8 / context.getTotalNunm

} else if (context.getSuperstep() >= 1) {
double sum = 0;
for (DoubleWritable msg :

sum += msg.get();
T

messages) {

1. Right-click the module source code directory src > > main, select new, and select

MaxCompute Java.

2. Select the GraphLoader/Vertex type and enter the class name (package name is supported) in

the Name text box. Click OK, and the frame code will be automatically filled in by the template,

you can continue to modify.

o ® Create new MaxCompute java class

Name:

Kind: /\ GraphLoader

I Extractor

{) Outputer
GraphLoader

Y\ Vertex

/| VertexResolver

/. Combiner

/\ Aggregator

. StorageHandler



https://www.alibabacloud.com/help/zh/doc-detail/50901.htm
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Debug Graph Locally

After the Graph program is developed, test your code and check whether it meets the expectatio

ns. You can run the Graph code locally.

1. Run the Graph program: Right-click the Driver class and select Run. In the displayed Run

Configuration dialog box, configure the MaxCompute project on which the Graph program

} [ JoX Run/Debug Configurations

+ o o
+ — [0 EH % a v » Name PageRank Share Single instance only

private static void printUsage() { MaxCompute Java

System.out.println("Usage: <in> <out> [Max iterations (default SSSP Main class: com.aliyun.odps.examples.graph.PageRank

System.exit( status: -1);
} PageRank

Kmeans VM options

public static void main(String[] args) throws IOException { MaxCompute Python
if (args.length < 2)

printUsage(); MaxCompute SQL

% Defaults
GraphJob job = [N RLA0);

job.setGraphLoaderClass (PageRankVertexReader.class) ;
job.setVertexClass(PageRankVertex.class);
job.addInput(TableInfo.builder().tableName(args[0]

Program arguments: pagerank_in pagerank_out

g directory: |~ I

Environment variables:

Lbuild());

h of B h

job.addOutput(TableInfo.builder().tableName(args[1]).build()); Use classpath of module; grap <]
// default max iteration is 30 JRE: Default (1.8 - SDK of 'graph’ module) |~
Ji?biz.e—égaf;;ﬁtﬁngm; Shorten command line: user-local default: none r <]

job.setMaxIteration(Integer.parseInt(args[2])); Enable capturing form snapshots

long startTime = System.currentTimeMillis();

job.run(); . . “MaxCompute project: example_project o+
System.out.println("Job Finished in " + (System.currentTimeMill
" + " seconds"); Download Record limit: 100

~ Before launch: Build, Activate tool window
44 Build
+

Show this page Activate tool window

? Cancel Apply [

ageRank main()
26:TODO [ Terminal 5] 0: Messages

mpleted successfully in 2s 674ms (2 minutes ago)

2. Click OK. If table data of the specified MaxCompute project is not downloaded to warehouse,
download data first. If a mock project is used or the MaxCompute project table data is
downloaded, skip this step. Then, the graph local run framework reads specified table data
in warehouse as the Graph input and runs the Graph program locally. You can view log output
and result display on the console. Each time you debug locally , a new temporary directory is

created under the Intellij directory, as shown in the following figure:



B Project v @ =  #- |- (@ pageRankjava

, 5 ; e e e e s
v san‘ddbox ~/1deaProjects/sandbox vertex.addEdge (new Text(edge.toString()), NullWritable.get());
.idea
graph ¥
@k System.out.println(“vertex edgs size: " + (vertex.hasEdges() ? vertex.getEdges().size() : 0));
. context.addVertexRequest(vertex);
scripts
target
temp ¥
=T
jgraph_2018032214406344 private static void printUsage() {
counters €— R THI—LHEIE R System.out.println("Usage: <in> <out> [Max iterations (default 30)1");
input €—— {EAl AY5H N\ U System.exit( status: -1);
output-€—— R HH IR b
resource<—1’£jﬂf‘kﬂﬂ\ﬂﬁ\ X @ ‘public static void main(String[] args) throws IOException {
superSteps ¢—— S—ERATE BHAMESR if (args.length < 2)
o job.xm| €— {EVER & printUsage();
warehouse
) LlEgnew GraphJobOH
< sandbox.iml GraphJob job = [TTNEENEAE)
|lll External Libraries job.setGraphLoaderClass (PageRankVertexReader. class) ;

inh.setVertexClass(PaaeRankVertex.class) :
PageRank main()

Run '\ PageRank

: Start to write table scheme : example_project.pagerank_out-->/Users/liuy1/ldeaProjects/sandbox/temp/graph_20180322144903_b34_14/6/output/__default__

>t 22, 2018 2:49:03 T4 com.aliyun.odps.local.common.utils.SchemaUtils generateSchemaFile
3 : generate schema file: /Users/liuyi/IdeaProjects/sandbox/temp/graph_20180322144903_634_1476/output/__default__/__schema__
_ 22, 2018 2:49:03 T4 com.aliyun.odps.local.common.utils.SchemaUtils generateSchemaFile
= : Finished to write table scheme : example_project.pagerank_out-—>/Users/liuyi/IdeaProjects/sandbox/temp/graph_20180322144903_634_1476/output/__default__

. 22, 2018 2:49:03 T4 com.aliyun.odps.graph.local.master.Master init
B za: :
E8: worker num :1

-
=2
oo W 4
= vertex edgs size: 2
2 2
b4 3
o vertex edgs size: 2
?
2
3

E] Note:

For a detailed introduction to warehouse, see Local Warehouse Directory section in Develop

UDF.
Run the Graph Program in the Production Environment

After local debugging is complete, release the Graph program to the server and run it in the

MaxCompute distributed environment.

1. Package the Graph program to a JAR package and release it to the server. For more
information, see How to package and release Graph.

2. Use the MaxCompute console integrated with MaxCompute Studio in seamless mode, that is,
in the Project Explorer Window, right-click Project and select Open in Console, and input the

commands similar to the following JAR command in the console command line:

jar -libjars xxx.jar -classpath /Users/hone/xxx.jar com aliyun. odps.
gr aph. exanpl es. PageRank pagerank_i n pagerank_out ;

2.5 Configure options


https://www.alibabacloud.com/help/zh/doc-detail/50902.htm
https://www.alibabacloud.com/help/zh/doc-detail/50902.htm
https://www.alibabacloud.com/help/zh/doc-detail/50904.htm
https://www.alibabacloud.com/help/zh/doc-detail/50904.htm
https://www.alibabacloud.com/help/zh/doc-detail/27878.htm

2.5.1 Configure MaxCompute Studio
After the MaxCompute Studio plug-in is installed, you can find configuration items of MaxCompute
Studio on the left bar of the Settings page of Intellid IDEA. For more information about how to

open the IntellidJ IDEA configuration page, see IntelliJ IDEA Documentation.

MaxCompute Studio configuration option page
The MaxCompute Studio configuration option page provides the following configuration items:
1. Path for storing the local metadata base

Specifies the path for locally storing metadata of a MaxCompute project. On MaxCompute
Studio, the metadata is stored in the hidden directory . odps. st udi o/ et a of the local user

directory by default.

2. Version update options

* You can use the Automatically checks for new version check box to control whether

MaxCompute Studio automatically checks for new version updates.

* You can use the Check new versions button to manually check new versions. After you
click this button, if a new version is available, the Install new version button is displayed.
You can click this button to install the new version, and restart IntelliJ IDEA after the

installation is complete.
SDK and Console configuration option page
The SDK and Console configuration option page provides the following configuration items:
1. Path for installing a MaxCompute client

Specifies the path for local installation of MaxCompute client. MaxCompute Studio detects the
version of the MaxCompute client installed in the path. If detection fails, an error message is

prompted.

Note:
MaxCompute Studio later than the 2.6.1 version provides the latest MaxCompute client. You
do not need to specify the path. If you must use a MaxCompute client of a specific version,

you can specify the path.
MaxCompute SQL configuration option page
The MaxCompute SQL configuration option page provides the following configuration items:

1. Enable syntax coloring


https://www.jetbrains.com/help/idea/2016.3/accessing-settings.html

Select Enable syntax coloring to enable the syntax highlighting feature.

2. Enable code completion

Select Enable code completion to enable the automatic code complementing feature.

3. Enable code formatting

Select Enable code formatting to enable the code formatting feature.

4. Compiler options

These are global default compiler options. The following options can be separately set for each

file on the toolbar of the SQL compiler.
* Compiler Mode

- Statement Mode: In this mode, the compiler compiles and submits a single statement of
an SQL file as a unit.

= Script Mode: In this mode, the compiler compiles and submits an entire SQL file as a
unit. NOTE: Script Mode enables the compiler and optimizer to optimize the execution

plan and improve the overall execution efficiency. This mode is in the test phase now.

* Type System

— Legacy TypeSystem: Indicates the type system of original MaxCompute.

— MaxCompute TypeSystem: Indicates the new type system introduced by MaxCompute 2
.0.

— Hive Compatible TypeSystem: Indicates the type system in Hive compatibility mode

introduced by MaxCompute 2.0.

» Compiler Version

= Default Version: Indicates the default version of the compiler.
= Flighting Version: Indicates the experimental version of the compiler, which includes new

features of the compiler being tested.
Account configuration option page

You can add or manage accounts used to access MaxCompute on the Account configuration

option page. For more information, see User authentication.

You must specify an account on MaxCompute Studio to access a MaxCompute project and run or

submit jobs. MaxCompute Studio currently supports the following account type:

+ Alibaba Cloud account (AccessKey)


SP_76/DNODPS1898901/EN-US_TP_12094.dita

Add an account
On the Account configuration option page, follow these steps:

1. Click +orpress Ctrl - N.
2. Select the account type Aliyun Account by AccessKey.

3. In the displayed Add Account window, set the following items:

+ Account Nane: Indicates the name of the account on MaxCompute Studio.

« Using properties fil e:Readthe AccessKey ID and AccessKey Secret from the

configuration file.

= Select the configuration file conf/ odps_confi g. i ni after you process User

authentication.

+ Using properti es: Manually enter the AccessKey ID and AccessKey Secret.

— Access | d: Enter the AccessKey ID of your Alibaba Cloud account.

— Access Key: Enter the AccessKey Secret of your Alibaba Cloud account.

- %

Add MaxCompute project | 22 |

Odps.ini files need to be
downloaded in advance to initialize

Connection  Setling ¢ ration items such as AK/Endpoi

Properties File: load\MaxCompute Client\conf\odps_config.ini

AK Account: sing AK account to initialize AK, yau can
click on the right + to ad«d.

* Access Id: LT A g i 17 1hD

* Access Key: oAPref Tl et Sl Aa®0 2R r2) JEF
* Project Mame: | MySecondProject2

* End Point: http://service.odps.aliyun.com/api

) Cancel

4. Click OK to complete addition. Then, the account will be displayed in the Account list on the

Account configuration option page.
Delete an account

On the Account configuration option page, follow these steps: (This operation only deletes the

account configuration on Studio configuration, which does not affect your account.)


SP_76/DNODPS1898901/EN-US_TP_12094.dita
SP_76/DNODPS1898901/EN-US_TP_12094.dita

1. Select the account to be deleted in the Account list.
2. Click -.

3. In the displayed dialog box, click OK.
Modify the AccessKey of an account
On the Account configuration option page, follow these steps:

1. Select the account to be deleted in the Account list.
2. Click the pencil icon.
3. In the displayed Edit Account window, modify the account information. The content is similar

to that in the preceding section Add Account.

View the opening and connection of MaxCompute Region and the settings of Endpoint, see

Endpoints and Data Centers.



3 Downloads

This document provides you with the download address of the relevant tools and plugins.

+ SDK Downloads: Maven users can search odps-sdk from Maven library to get different

versions of the Java SDK.
*  MaxCompute console
» Eclipse plugin
» Intelij plugin, Studio


http://repo.aliyun.com/download/odpscmd/latest/odpscmd_public.zip
https://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/cn/odps/0.0.90/assets/download/odps-eclipse-plugin-bundle-0.16.0.zip
https://www.jetbrains.com/idea/?spm=5176.doc50891.2.4.2O5djt
https://plugins.jetbrains.com/plugin/9193-maxcompute-studio
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